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Q1. Who first introduced the
formal academic concept of
Emotional Intelligence in
1990?

e A) Daniel Goleman

e B) Howard Gardner

e () Peter Salovey and John Mayer
e D) Reuven Bar-On

¥ Answer: C — Peter Salovey and

John Mayer They published the first
academic model of EIL

Q3. What is the core difference
between EI and IQ?

e A)IQ measures emotional ability;
EI cognitive

» B)IQis flexible; EI is fixed

e () IQ predicts academic; EI predicts
leadership

e D) They measure the same
capabilities

¥ Answer: C — IQ predicts
academic; EI predicts leadership EI is
a developable set of performance-

based skills.

Q2. In what year was Daniel
Goleman's popular book on
Emotional Intelligence
published?

« A)1990
. B)1983
e C)1995
e D)2000

# Answer: C — 1995 This publication
brought EI into the mainstream.

Q4. According to TalentSmart,
what percentage of job
performance does EI predict?

e A)25%
« B)38%
e C)58%
e D) 72%

¥ Answer: C — 58% EI is a primary
predictor of workplace performance.
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Q5. Thorndike's "Social
Intelligence” (1920) is the root
of which concept?

o A) Multiple Intelligences

» B) Emotional Intelligence

e () Cognitive Behavioral Therapy
e D) Growth Mindset

M Answer: B Thorndike's work is the
historical precursor to modern EL

Q7. As Al automates tasks,
what is the human
competitive advantage?

e A) Technical expertise

e B) Data analysis

e C) Emotional Intelligence

e D) Speed of execution

M Answer: C Al cannot replicate

human empathy and complex
emotional judgment.

Q6. What is the relationship
between EI and Social
Intelligence?

e A) They are identical

» B) Social Intelligence is the
foundation

» () Elis the foundation, Social
Intelligence the application

e D) El s for self, Social Intelligence

for others

M Answer: C Self-awareness is
necessary to navigate interactions
with others.

Q8. The World Economic
Forum ranks EI among which
of these?

e A) Declining workplace skills

e B) Top 10 workplace skills of the
future

e () Core digital technical skills
» D) Skills for senior leaders only

W Answer: B The WEF identifies EI as
critical for future professional success.
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Q9. Which best defines Self-
Awareness in Emotional
Intelligence?

e A) Suppressing negative emotions

e B) Understanding your emotions,
impact, and values

» () Receiving positive peer
feedback

o D) Predicting others' feelings

M Answer: B It is the foundational
pillar of EL

Q11. What is the purpose of a
Body Scan?

e A) Assessing physical fitness

» B) Detecting physical signs of
emotions early

e C) Improving posture during
meetings

e D) Measuring heart rate

™ Answer: B Noticing physical signs
early is vital.

Q10. What is "Emotional
Granularity”?

e A) Feeling many emotions at once

» B) Using precise, specific emotion
words

e () Scoring emotions numerically

e D) Categorizing into

positive/negative groups

# Answer: B Precise labeling enables
targeted regulation.

Q12. How does Mindfulness
help EI?
e A)Eliminating negative emotions

o B) Creating a gap between
stimulus and response

e () Increasing cognitive processing
speed

e D) Replacing emotions with
rational analysis

W Answer: B It reduces immediate
emotional reactivity.
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Q13. "Belief Examination’
relates to which EI pillar?

e A) Social Skills

e B) Motivation

e () Self-Awareness

e D) Empathy

M Answer: C It uncovers the

narratives driving your emotional
response.

Q15. What is an "Amygdala
Hijack” and its originator?
» A) Deep focus; Csikszentmihalyi

e B) Emotional brain overriding
rational; Goleman

e () Cognitive bias; Kahneman
e D) Emotion suppression; Ekman
M Answer: B The emotional brain

bypasses rational thought during
threats.

Q14. Which tool captures
external perspectives on your
behavior?

A) Body scanning

B) Emotion journaling
C) 360-degree feedback
D) Mindfulness

¥ Answer: C It provides essential
data on how colleagues perceive you.

Q16. The "6-second pause”
relies on what principle?

A) Oxygen flow speed
B) Cortisol spike duration
C) Nervous system activation

D) Memory consolidation

¥ Answer: B This wait allows the
initial neurochemical surge to subside.
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Q17. Cognitive Restructuring
involves:

e A) Avoiding triggers

» B) Challenging automatic thoughts
and replacing with balanced
perspectives

e C) Suppressing reactions
e D) Seeking external validation
¥ Answer: B It consciously shifts

emotional responses by reframing
thoughts.

Q19. Viktor Frankl's "space
between stimulus and
response” relates to:

e A)Empathy

e B) Social Skills

o () Self-Management / Regulation

e D) Motivation

™ Answer: C This describes using the

pause before reacting to maintain
control.

Q18. Difference between
Suppression and Regulation?

e A) They are the same

» B) Suppression ignores emotions;
regulation involves conscious
processing

e () Regulation is for negatives only
e D) Suppression is healthy long-

term

¥ Answer: B Suppression pushes
emotions down, while regulation
manages them consciously.

Q20. Why does Box Breathing
help regulation?
e A) It increases cortisol

» B) It activates the parasympathetic
nervous system

e () It improves oxygen flow
e D) It stimulates the amygdala
™ Answer: B Controlled breathing

calms the nervous system’s stress
response.
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Q21. Goleman's EI framework:
Which is NOT a motivation
marker?

e A) Achievement drive

e B) Financial ambition

e C)Optimism

e D) Initiative

M Answer: B — Financial ambition

Goleman emphasizes intrinsic
motivators over financial gain.

Q23. Why is the WOOP model
considered more emotionally
intelligent?

e A)Itignores negative outcomes

» B) It includes an Obstacle step for
internal resistance

e C) It replaces targets with
intentions

e D) Itis designed for leadership

W Answer: B — It includes an
Obstacle step for internal resistance

It explicitly accounts for inner barriers

like self-doubt.

Q22. How is "Realistic
Optimism"” best defined?

e A) Maintaining blind positivity

» B) Acknowledging difficulty while
believing in success

e () Ignoring negative outcomes

e D) Overriding risk assessments

¥ Answer: B — Acknowledging

difficulty while believing in success

It balances awareness of obstacles
with belief in one’s capacity.

Q24. Resilience in the context
of El is defined as:

e A) Absence of emotional distress

» B) Suppressing reactions

» () Recovering and growing from
setbacks

» D) Returning to a pre-setback state

# Answer: C — Recovering and
growing from setbacks It is the
ability to process and adapt to
adversity.
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Q25. What is the sequence for
building resilience after a
setback?

e A) Deny - Reframe -» Move On

e B) Acceptance > Meaning-Making
- Forward Focus

e () React » Suppress > Restart
e D) Analyze » Blame - Correct
M Answer: B Resilience requires

acknowledging the event, finding
purpose, and focusing on next steps.

Q27. What does Carl Rogers’
"Unconditional Positive
Regard” mean?

o A) Agreeing with everything

e B) Valuing someone’s humanity,
distinct from their behavior

e () Giving unconditional praise

» D) Withholding judgment

M Answer: B This principle separates
human worth from specific actions.

Q26. Which empathy type
involves feeling others'
emotions AND acting to help?

e A) Cognitive
e B) Emotional
» () Compassionate

e D) Reflective

¥ Answer: C Compassionate
empathy combines emotional
resonance with proactive support.

Q28. What is "Compassion
Fatigue"?

* A) General fatigue

» B) Reducing empathy for distance

e () Emotional depletion from
absorbing others’ pain

» D) Losing motivation
W Answer: C This occurs when

dissolving boundaries leads to
internalizing others’ distress.
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Q29. A leader saying "1
understand your view, even if I
disagree” shows:

e A) Poor empathy

» B) Cognitive empathy

» () Emotional suppression

e D) Commanding style

# Answer: B — Cognitive empathy
Empathy enables understanding

perspectives without requiring
agreement.

Q31. The SBI Feedback Model
stands for:

» A) Skills, Behavior, Improvement
» B) Situation, Behavior, Impact

e C) Summary, Background,
Intention

e D) Self-awareness, Behavior,
Insight

M Answer: B — Situation, Behavior,
Impact This framework centers on
observable behaviors and their effects.

Q30. Which behavior best
demonstrates workplace
empathy?

e A) Sending a mental health email

» B) Checking wellbeing before
performance

e () Giving bonuses to stressed staff
e D) Delegating without explanation
¥ Answer: B — Checking wellbeing
before performance Prioritizing the

person shows genuine concern for
their wellbeing.

Q32. What is the first step in EI
conflict resolution?

» A) Present your perspective

» B) Identify fault

* () Regulate emotions

» D) Involve a third party

# Answer: C — Regulate emotions

Self-regulation is essential to prevent
conflict escalation.
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Q33. Healthy emotional
boundaries are best described
as:

e A) Maintaining strict professional
distance

» B) Distinguishing your emotions
from others' to protect energy

e () Refusing emotional topics at
work

e D) Sharing only with trusted
individuals

¥ Answer: B Boundaries enable clear
engagement without absorbing
others’ emotional states.

Q35. Which leadership styles
create the strongest team
climate?

e A)Commanding
e B) Pacesetting

e () Visionary, Coaching, and
Affiliative

e D) Democratic and Pacesetting
¥ Answer: C These styles

consistently foster the most positive
organizational environments.

Q34. Why use "I" statements
in difficult conversations?

e A) It removes speaker
responsibility

e B) It focuses on your experience to
reduce defensiveness

e () It makes the tone more formal

D) It signals emotional detachment

W Answer: B "I” statements invite

dialogue rather than triggering
blame-based defensiveness.

Q36. What is the high-EI
response to VUCA volatility?

e A) Deciding quickly to reduce
uncertainty

e B) Remaining an emotional anchor
amidst the chaos

e () Increasing oversight and control

e D) Delaying decisions until
stability returns

¥ Answer: B Leaders should act as
steady anchors rather than reflecting
external chaos.
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Q37. A leader using the

Coaching style focuses

primarily on:

e A) Direct instruction for
immediate results

e B) Maintaining harmony and
minimizing conflict

e () Developing long-term employee
capabilities

e D) Achieving team consensus on
decisions

¥ Answer: C
Prioritizes long-term growth over
short-term efficiency.

Q39. If an employee becomes
defensive during SBI feedback,
the high-EI response is to:

o A) Reiterate the feedback firmly
o B) Withdraw the feedback

e () Acknowledge emotions and
allow for their perspective

e D) Escalate the issue to HR
¥ Answer: C

Validating feelings maintains a
productive, open dialogue.

Q38. Psychological Safety is
most directly driven by which
EI competencies?

e A) Motivation
o B) Self-Regulation and Empathy

e () Technical expertise and
decisiveness

e D) Social awareness alone

¥ Answer: B
Leaders foster safety through

emotional regulation and genuine
empathy.

Q40. Which is the most
accurate indicator of LOW
leader EI?

e A) Expressing emotion during hard
times

e B) Regularly soliciting feedback

e () Team hides problems until they
become crises

» D) Adapting communication styles

¥ Answer: C
Teams conceal issues when they fear a

leader’s reaction.
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Q41. What is the correct
sequence of stages in the
GROW coaching model?

e A) Goals ~ Results » Options >
Work

» B) Goal » Reality - Options » Will

e () Growth - Reflection >
Outcomes > Work

e D) Goal -» Resources - Obstacles -»
Wins

¥ Answer: B — Goal - Reality >

Options » Will This framework

Structures progress from outcomes to
commitment.

Q43. What is the primary EI
challenge of leading virtual
teams?

» A) Difficulty in using financial
incentives
e B) Increased cultural differences

e () Natural emotional signals must
be actively created

e D) Need for higher technical
knowledge

¥ Answer: C — Emotional signals
that occur naturally in person must
be actively created and sought out
virtually Leaders must intentionally
compensate for lost physical cues.

Q42. What does Level 3
Listening refer to in coaching?

e A) Listening while taking detailed
notes

e B) Focusing only on spoken words

e () Global listening: attending to
tone, energy, and what is unsaid

» D) Listening to provide helpful
advice

¥ Answer: C — Global listening —
attending to tone, energy, body
language, and what is NOT being
said This captures the full emotional
and unspoken context.

Q44. A virtual team member is

unusually quiet. What is the

high-EI response?

e A) Send a formal request for
participation

» B) Note it for the next review cycle

e () Privately check in with genuine,
low-pressure care

e D) Address it in a team meeting

¥ Answer: C — Reach out privately
with a genuine, low-pressure check-
in Private check-ins foster connection
without triggering defensiveness.
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Q45. Core distinction between Q46. Which EI model is

Manager and Coach? "ability-based”?

e A) Managers are hierarchically e A) Goleman's Mixed Model
senior ¢ B) Bar-On's Trait Model

» B) Managers direct; coaches ask  C) Mayer-Salovey-Caruso Ability
questions to build capability Model

» C) Coaching is for e D) Petrides' Trait EI Model

underperformers only
W Answer: C It measures EI as a

* D) Managers focus on individuals; cognitive capacity for emotional

coaches on teams

processing.
# Answer: B Coaching empowers
others to develop their own solutions.
Q47. Taking accountability for Q48. "Equitable turn-taking”
emotional reactions comes from which study?
demonstrates: e A) Stanford's Project Empathy
* A) Empathy  B) Google's Project Aristotle
» B) Social Skills e C)Harvard's Psychological Safety
o () Self-Management Study
e D) Motivation e D) McKinsey's Leadership Report
# Answer: C Owning one'’s emotional ¥ Answer: B Balanced participation
state is fundamental to self- predicts high team effectiveness.

management.
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Q49—Q50: Leadership Styles & EI

Q49. A leader demanding Q50. Which is most accurate
immediate compliance in a regarding EI development?

e o . ?
crisis uses which styles » A)Fixedby geneticsfage 30
* A)Pacesetting e B) Developable via practice and
» B) Affiliative coaching
e C)Commanding » () Requires formal therapy
e D) Democratic » D) Fixed by adolescence
¥ Answer: C — Commanding ¥ Answer: B — Developable via
Effective for short-term crisis practice and coaching EI is
management. neuroplastic and strengthenable at

any age.
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